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Executive Summary 

Conventional culverts are mainly designed to transport water underneath roadways with minimal 
headwater buildup, resulting in low to moderate peak flow attenuation. On-road structures (ORS) 
offer an alternative by using the roadway embankment as a dam, restricting flow into the culvert 
to provide flood storage during large precipitation events. Our project conducted statewide GIS 
analyses and identified approximately 250,000 potential ORS locations, with a combined storage 
capacity of 2 million acre-feet and a pool area covering 900,000 acres, representing about 2.7% 
of Iowa. This project developed a methodology to automate the hydrologic design of individual 
ORS, enhancing the identification of those that offer significant peak flow reduction benefits. In 
addition, this project also quantified the peak flow reduction benefits at the HUC12 watershed 
scale for ORS systems. For a 50-year storm event, peak flows at watershed outlets were reduced 
by approximately 18%. The research outcomes are accessible through a web portal named the 
Iowa DOT On-Road Structures (IDOT-ORS) information platform. This platform facilitates the 
dissemination of results, allowing various stakeholders to view information on ORS locations, 
expected pool and drainage areas, structure designs, and inflow and outflow hydrographs for 
several return periods. The platform can be accessed at 
https://hydroinformatics.uiowa.edu/lab/idot-ors/. 
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1. PROBLEM STATEMENT AND OBJECTIVES 
One of the main objectives of traditional culvert design is to allow flood waves to pass from one 
side of the road to the other with relatively low headwater elevation, leading to low to moderate 
peak flow attenuation (Schall, 2012). During heavy precipitation events, flows passing quickly 
through upstream culverts are more likely to combine and potentially overwhelm downstream 
culverts, damage bridges, roads and infrastructure, and impact downstream communities and 
farms. 

On-road structures (ORS) present a viable alternative to traditional culvert design, with the 
potential to mitigate flood impacts. ORS utilize the roadway embankment as a dam, restricting 
flow into the culvert to provide flood storage for significant peak flow events (e.g., up to the 50- 
or 100-year return period). Figure 1 presents examples of ORS built in Northeast Iowa. Several 
counties in Iowa have implemented ORS in HUC12 watersheds, and anecdotal evidence suggests 
that these structures have reduced the flood impacts of recent extreme rainfall events. However, 
Iowa lacks a detailed statewide geospatial database identifying which existing culverts are suitable 
candidates for conversion to ORS. Additionally, a HUC12-scale assessment of the potential for 
peak flow reductions of a system of ORS has not yet been conducted. 

 

Figure 1. Examples of on-road structures located in Northeast Iowa. 
 
This project addressed these knowledge gaps by integrating GIS and hydrologic analysis, 
rainfall-runoff modeling, and hydroinformatics. Specifically, the objectives of this project were 
to: 

 
1. Construct a statewide geospatial database identifying suitable locations for the 

construction of ORS, including information on flood storage, expected pool areas, 
and drainage areas. 
 

2. Develop a methodology to programmatically complete planning designs for the 
individual ORS identified in Obj. 1. These designs will allow for the estimation of 
structure-level peak flow reductions under different design storm scenarios. This 
work was completed in six selected HUC12 watersheds. 
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3. Assess the HUC12-scale flood reduction benefits of a system of ORS. To achieve 

this, the research team used the process-based hydrologic model GHOST described in 
Politano et al. (2023). This work was also completed in six selected HUC12 
watersheds. 
 

4. Leverage the research team's expertise in hydroinformatics to develop a web platform 
to communicate the results of Objectives 1-3. 

 
In this project, the research team worked closely with DOT and the Technical Advisory Committee 
(TAC) to select the HUC12s for the hydrologic simulations, find ways to best communicate the 
results of the hydrologic and statewide GIS-based analyses and design the proposed website to 
disseminate project’s results. 

 

2. BACKGROUND INFORMATION 
This section outlines the magnitude and severity of the flooding problem in Iowa, provides 
examples of existing ORS, and discusses the application of hydrologic modeling to evaluate flood 
mitigation strategies. Additionally, it highlights the use of web-based information systems in Iowa 
to support these efforts.       

a. Flooding in Iowa 
Flooding is one of the most pressing challenges facing Iowa. Records maintained by the Federal 
Emergency Management Agency (FEMA) indicate that out of the approximately 1,300 federally 
declared disasters in Iowa counties from 1989 to 2022, approximately 80% were related to flooding 
(Figure 2) . Iowa's estimated losses from flooding are substantial. The SHELDUS database (1988-
2015) reports $13.5 billion in direct property losses and $4.1 billion in direct crop losses 
(https://cemhs.asu.edu/SHELDUS/). In 2019 alone, the National Oceanic and Atmospheric 
Administration (NOAA) estimates that extreme weather generated losses of approximately $1.9 
billion in Iowa, with flooding being the main driver of these losses. Improving Iowa's resilience to 
flooding will require significant investment, creative thinking, and innovation. ORS are an 
example of how infrastructure repair or replacement investments can be used to lessen the future 
impacts of flooding. By temporarily retaining water runoff from high-intensity precipitation 
events, ORS can reduce damage to county roads, bridges, and culverts, and protect downstream 
communities and farmland. 
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Figure 2. Flood-related disaster declarations in Iowa counties (1989–2022). Raw data: 
https://www.fema.gov/ 

b. Examples of On-road Structures in Iowa 
The North Bear Creek HUC12 watershed spans Allamakee and Winneshiek counties in Iowa, as 
well as Fillmore and Houston counties in Minnesota. This watershed has pioneered the installation 
of ORS in both Iowa and Minnesota, with stakeholders identifying 56 locations suitable for 
constructing these structures (Figure 3). 

The U.S. Department of Housing and Urban Development funded The Iowa Flood Center (IFC) 
to lead the Iowa Watersheds Project (IWP, Weber et al., 2018). The IWP focused on selected Iowa 
watersheds, developing comprehensive watershed plans and collaborating with local volunteers to 
design and build water management projects. In its second phase, the IWP supported the 
construction of five ORS, along with several ponds and WASCOBs in the Otter Creek HUC12 in 
Fayette County (Figure 4). Analyses presented by IFC (2016) demonstrated that ORS were the 
most effective in reducing peak discharges, providing an estimated 30% peak flow reduction for 
50-year recurrence flows in some tributaries. More recently, the Iowa Watershed Approach 
Project, funded through the National Disaster Resilience Competition, has also sponsored the 
construction of ORS in Iowa (https://iowawatershedapproach.org/). 

https://www.fema.gov/
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Figure 3. ORS in North Bear Creek. 

 

Figure 4. IWP Phase II project locations in the Otter Creek Watershed. 
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c. Distributed Storage and Hydrologic Modeling 
Several studies have demonstrated the efficacy of distributed storage systems in mitigating flood 
impacts (Thomas et al., 2016; Ayalew et al., 2017). While the flood reduction benefit from a single 
detention structure may not be significant at the watershed scale (e.g., the outlet of a HUC12), the 
combined effect of multiple structures can be substantial. In recent years, three projects in Iowa 
have extensively evaluated hypothetical and constructed detention structures (mostly off-road 
structures) located in watershed headwater catchments: the Iowa Watersheds Project (IWP, Weber 
et al., 2018), the Iowa Watershed Approach (https://iowawatershedapproach.org/), and the Des 
Moines River Upstream Mitigation Study (Arenas et al., 2020). 

d. Web-based Information Systems 
Our research team has expertise in the creation of user-friendly, interactive, web-based information 
systems to communicate environmental and geospatial information in Iowa and the United States 
(Xu et al., 2019a; Xu et al., 2019b; Demir and Krajewski, 2013; Demir et al., 2018). Some 
examples of this type of website include: 

• The Iowa Dot Culvert Platform provides information on culverts throughout the state of 
Iowa. https://apps.iowadot.gov/culverts/ 

• The Iowa Flood Information System. A comprehensive web-platform to access 
community-based flood conditions, forecasts, visualizations, inundation maps, and flood-
related information. http://ifis.iowafloodcenter.org/ifis/ 

• The Iowa Water Quality Information System. This website integrates real-time water-
quality data collected by IIHR and the USGS, along with a variety of watershed-related 
information such as precipitation, stream flow and stage, soil moisture, and land use. 
https://iwqis.iowawis.org/ 

 

3. METHODOLOGY 
The objectives of this project were accomplished following the methodology described below. 

a. Statewide GIS Analyses 

The statewide GIS analyses were developed using 2-meter Digital Elevation Models (DEMs) for 
all the HUC12 watersheds in Iowa. For each watershed, DEMs were modified to ensure the 
elevation datasets accurately reflected how water moves across the landscape by following a 
hydroenforcement or hydroconditioning process. Special attention was given to the intersections 
of roadways and waterways, where cuts were added to the DEMs at crossings as needed. Following 
this, flow paths starting at a drainage area accumulation of 10 acres were generated as presented 
in Figure 5.   

 

 

https://apps.iowadot.gov/culverts/
http://ifis.iowafloodcenter.org/ifis/
https://iwqis.iowawis.org/
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Figure 5. Left: DEM before hydroenforcement. Middle: cuts (culverts) were added, and flow paths 
were generated. Right: storage pools were estimated assuming three different ORS elevations: 50%, 
70%, and 90% of the road height.   

 

Eight steps were followed to calculate storage volumes behind ORS: 

 
1. Create Intersection Points: 

Use the flow path and intersect it with road coverage (Analysis Tools > Overlay > Intersect) 
to create intersection points. 
 

2. Buffer and Clip Road Coverage: 
For each point in the intersection coverage, create a 10-meter buffer (Analysis Tools > 
Proximity > Buffer). Clip the road coverage with the buffer (Analysis Tools > Extract > 
Clip). 
 

3. Obtain Road Elevation: 
Run Zonal Statistics (Spatial Analyst Tools > Zonal > Zonal Statistics as Table) on the 
clipped road segment to obtain the elevation of the road. Use the median value as the road 
elevation and the minimum value as the base elevation. Calculate the road height as the 
median elevation minus the minimum elevation. Calculate the height of the overflow 
structure as a percentage (50%, 70%, or 90%. See Figure 5) of the road height, with 50% 
as the default. Make the percentage variable so it can be adjusted as needed. 
 

4. Snap Intersection Point: 
Snap the intersection point (Spatial Analyst Tools > Hydrology > Snap Pour Point) to the 
Flow Accumulation grid using a 2-meter tolerance. 
 

5. Create Watershed: 
Use the snapped intersection point to create the watershed for the point (Spatial Analyst 
Tools > Hydrology > Watershed). 
 

6. Convert Watershed Grid to Polygon: 
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Convert the watershed grid to a polygon with “no simplify” (Conversion Tools > From 
Raster > Raster to Polygon). Calculate the area of the polygon in acres. 
 

7. Create Storage Pool Area Grid: 
Use the overflow structure height to reclassify the DEM and create a grid of the storage 
pool area (Spatial Analyst Tools > Reclass > Reclassify). Use two values: the structure 
height for the first value and NoData for everything higher. Set the extent and mask values 
to the watershed polygon to limit the reclassification to that area. 

8. Calculate Depth and Volume of Storage Pool: 
Use Raster Calculator to subtract the DEM from the pool elevation grid, creating a depth 
of storage pool grid. Calculate the volume of each pool elevation value using the formula: 
Ac_ft = ((Count * 4) / 4046.856) * (([Value] * 3.2808) / 100).  Run Statistics on Ac_ft to 
sum up value for total storage volume of pool. Convert storage pool grid to polygon and 
add storage volume to polygon and append to HUC12 coverage of storage pools. 

The process described above was completed using ESRI software and the Agricultural 
Conservation Planning Framework Preparation tools (https://acpf4watersheds.org/). 

b. Planning Designs 
To complete the planning designs, we conceptualized the ORS as a system comprising a horizontal 
pipe at the bottom (D1), a vertically positioned orifice (D2), and a riser pipe (D3) that can be 
adjusted to different elevations. Figure 6 provides a schematic representation of this system. These 
outlets operate in stages, activating progressively as water levels increase, which ensures efficient 
water management during varying storm intensities. The design and analysis of these ORS were 
automated using Python scripts in ArcGIS, enabling the programmatic design of many ORS. The 
following text describes the implementation and functionality of these scripts. 

 

Figure 6. Typical ORS. The figure presents the three outlets (D1, D2, and D3), activation levels, 
and the different storms considered during the iterative design process.  
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The structure presented in Figure 6 operates with varying activation levels as the water surface 
rises in response to different design storms. The first outlet (D1) handles the less severe design 
storms. As storm intensity increases, the second outlet (D2) is activated to manage higher runoff 
levels. Finally, the third outlet (D3) comes into play during the highest storm intensities to manage 
maximum runoff. This tiered response ensures effective water management and flood control for 
the on-road structures. 

A systematic approach was adopted using three Python scripts within ArcGIS to automate the 
design and analysis process of the ORS. These scripts operate in stages, starting with initial data 
derived from statewide GIS analysis described above.  

Script 1 

In the first stage, the hydrological analysis generates files with hydrological information. The input 
were DEMs, ORS location, and soil and land use information. The script performed the flow length 
generation Flow Length (Spatial Analyst) and the Curve Number (CN) calculation. The script 
computes, for each area that drains to the ORS, the composite CN by analyzing soil type and land 
cover gridded data. The input and output data are displayed in Table 1. 

Table 1. Script 1. Input and output data. 

  File Type     File Type 

In
pu

t D
at

a 

DEM Raster file   

O
ut

pu
t D

at
a 

DEM Fill Raster file 
On-road structures 

(ORS) Point Shapefile   Flow Direction Raster file 

Drainage Areas 
(DA) 

Polygon 
Shapefile   

Flow Length Raster file 
Land use Raster file   
Soil Type Raster file   DA with CN 

Composite values Polygon Shapefile Table CN vs 
Landcover Table   

 

Script 2 

The second script focused on hydrologic modeling using the rational method (Chow et al., 1988) 
and the CN model. The script follows these steps: 

1. Hydrological Values Computation: Hydrological parameters relevant to the design of 
ORS are computed. These values included time of concentration precipitation excess, 
rainfall intensity, and runoff coefficients for each watershed.  

 
2.  Peak Discharge Calculation (Q): The rational method (Chow et al., 1988) was applied to 

calculate each watershed's peak discharge (Q). This calculation was performed for 
multiple return periods for different storm events. 

 The input and output data are displayed in Table 2. 
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Table 2. Script 2. Input and output data 

  File Type     File Type 
In

pu
t D

at
a 

DEM Raster file   

O
ut

pu
t D

at
a 

Drainage Areas 
(DA) Polygon Shapefile 

Drainage Areas 
(DA) Polygon Shapefile   

Table Drainage 
Areas (DA) 

Table with the 
following values: 
Q (1, 2, 5, 10, 25, 
50, 100, 200, 500 

YR) 
Delta Elevation 

Length 
Road Elevation 

Time of 
concentration 

Flow Length Raster file   
Pool Area (50%, 

70% or 90%) Polygon Shapefile   

Precipitation 
Raster Files (1, 2, 

5, 10, 25, 50, 
100, 200, 500 

YR) 

Raster file   

 

Script 3 

The final stage involves determining D1, D2, and D3 (Figure 6). The script executed the following 
processes: 

1. Inflow Hydrograph: Using the data generated in the previous steps and applying the unit 
hydrograph methodology (USDA NRCS, 2007), along with the SCS Type II Rainfall 
Distribution the inflow hydrograph to the ORS is generated. 

 
2. Iterative outlet sizing. The script was developed to perform the following iterative design 

process: 
The bottom outlet (D1) is the initial discharge point, handling the initial runoff. The 
design process involves iterative testing of pipe diameters ranging from 4 to 24 inches 
and return periods of 1, 2, 5, and 10 years. The process involves finding the appropriate 
diameter and return period for which the water surface elevation does not activate the 
second outlet (D2). The criterion for this first outlet (D1) is that it should not exceed 30% 
of the road elevation. Once this step is completed, D1 is fixed, allowing the dimensioning 
of the remaining two outlets. 

The second outlet (D2). The horizontal pipe (D1) and the orifice (D2) work together when 
the water level rises to a moderate level, effectively managing increased runoff during more 
intense storms. The design process for D2 involves iteratively testing of pipe diameters 
ranging from 4 to 24 inches and return periods of 2, 5, 10, 25, 50, and 100 years. The 
process involves finding the appropriate diameter and return period for which the water 
surface elevation does not activate the third outlet (D3). The criterion for D2 is that it 
should not exceed 30% of the road elevation. Once this step is completed, D2 is fixed. 

The third outlet is the riser pipe (D3), which can be at 50%, 70%, or 90% of the road height, 
depending on the evaluated pool. This outlet engages during significant storms allowing 
the structure to manage maximum flows without overtopping the road. The design process 
involves iteratively testing of pipe diameters ranging from 24 to 72 inches and return 



10   
 

periods of 25, 50, 100, 200, and 500 years. The process involves finding the diameter and 
return period for which the water levels are below 90% of the road height.  
 
As a result of the design, the outflow hydrograph can be obtained for multiple return 
periods, which allows for the quantification of the peak flow reductions associated with 
each one of the ORS. Once D1, D2, and D3 are found stage-storage-discharge curves for 
each ORS can be generated. 

 

Table 3. Script 3. Input and output data. 

  File Type     File Type 

In
pu

t D
at

a 

DEM Raster file   

O
ut

pu
t D

at
a 

Stage-Storage 
and Discharge  

Curves and 
Tables 

DA with an 
attribute table 

containing design 
values. 

Polygon 
Shapefile   

Inlet and Outlet 
Hydrographs 

(D1, D2 and D3 
outlets) 

Curves and 
Tables Unit Hydrograph 

NRCS Table   
Rainfall 

Distribution (SCS 
Type II) Table   

 

c. HUC12 Scale Hydrologic Modeling 
For the six selected HUC12 watersheds depicted in Figure 7, we utilized the GHOST (Generic 
Hydrologic Overland-Subsurface Toolkit) model to evaluate the flood reduction benefits of ORS 
at the watershed scale. GHOST is a rainfall-runoff model extensively validated across various 
watersheds in Iowa. It is designed for both event-based and multi-year simulations in small 
catchments and large basins, employing finite volume techniques. Within GHOST, surface flows 
are simulated using a 2D diffusive wave approximation of the Saint Venant equations, while water 
depth in canals and streams is computed using a 1D approach. The model also simulates 
unsaturated zone dynamics under a vertical dominant flow assumption, and groundwater flow is 
governed by Darcy’s law. Processes such as infiltration, exfiltration, recharge, and lateral mass 
exchanges between surface and groundwater domains are accounted for in the flux calculations. 
Figure 8 highlights the key hydrologic processes incorporated within the GHOST model.  
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Figure 7. Selected HUC12 watersheds for the generation of planning designs for the ORS (Obj. 2) 
and watershed modeling (Obj. 3). 

 

 
Figure 8. Hydrologic processes, domains, and fluxes modeled in GHOST. 
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The predictive capabilities of GHOST have been extensively validated across various watersheds 
in Iowa, encompassing diverse soil types, topographies, land covers, geological histories, and 
hydrologic conditions. For this project, existing GHOST models that were previously calibrated 
were leveraged, obviating the need for additional model calibration or parameter estimation. 
Further details on the GHOST model and its performance across Iowa watersheds can be found 
in Arenas et al. (2020), Weber et al. (2023a), Weber et al. (2023b), Young et al. (2023), and 
Politano et al. (2023). 
 
In the study of the six selected HUC12 watersheds (Figure 7), the research team assessed the 
hydrologic model's ability to predict peak flows by comparing modeled outputs against data from 
StreamStats (Ries III et al., 2017). The comparison revealed that the best agreement between 
peak flows predicted by GHOST and StreamStats occurred at the 50-year return period, which 
was consequently chosen for the analyses. 
 

d. Web Platform 
In the project, cyberinfrastructure concepts were used to develop the Iowa DOT On-Road 
Structures (IDOT-ORS) information platform available through this URL: 

https://hydroinformatics.uiowa.edu/lab/idot-ors/ 

This platform facilitates access to location, and pool and drainage areas for existing and potential 
on-road structures in Iowa. In addition, in selected HUC12 watersheds (Figure 7) displays the 
results of the planning designs.  

The core functionalities and capabilities of the system include: 

a) A web-based cyberinfrastructure designed for information sharing and communication 
regarding on-road structures. It features advanced visualization and filtering tools, supported by a 
relational database housing data and model outputs from the data analytics sub-system. 

b) Data analytics components for modeling and analysis. These components evaluate the flood 
reduction benefits of existing and potential on-road structures and estimate flood storage potential 
from ORS. 

The web platform enables users to visualize project results across various spatial scales. For 
watersheds without planning designs, users can view the locations of viable ORS identified 
through statewide GIS analyses, along with corresponding pool polygons, drainage areas, and flow 
paths. Additionally, aggregated total storage can be visualized at the HUC12 scale, as depicted in 
Figure 9. Moreover, for HUC12 watersheds with planning designs, users can access final design 
results, including values of D1, D2, and D3 (referenced in Figure 6), as well as hydrographs 
showing inflows and outflows for multiple return periods. 

https://hydroinformatics.uiowa.edu/lab/idot-ors/


  13 
 

 

Figure 9. Iowa DOT On-Road Structures (IDOT-ORS) information platform. Aggregated flood 
storage at the HUC12 level. https://hydroinformatics.uiowa.edu/lab/idot-ors/ 
        
The cyber system serves as a pivotal integration point among the project components, facilitating 
the communication of data and modeling outcomes. Recent community-wide initiatives 
underscore the importance of deploying information and communication technologies to advance 
environmental and geo-science research. Data within natural sciences are frequently high-
dimensional, posing challenges in comprehending and extracting meaningful patterns. One 
effective strategy to enhance comprehension involves providing visual insights into analyzed 
datasets. Data and information visualization offers graphical, often interactive representations of 
multi-dimensional datasets, empowering users to grasp and extract information for further 
investigation. The IDOT-ORS platform enables users to explore and evaluate analysis results 
through an interactive user interface. It provides accessible information on the flood reduction 
benefits of existing on-road structures and estimates the flood storage potential from new ORS in 
a user-friendly and intuitive cyber environment. 
 
4. RESULTS 

a. Statewide GIS Analyses 
Our statewide analysis identified approximately 250,000 ORS, with a combined storage capacity 
of 2 million acre-feet and a pool area covering 900,000 acres, which accounts for about 2.7% of 
the state of Iowa. Interesting patterns emerge when aggregating the results at the HUC12, HUC8, 
and county levels, as shown in Figures 10, 11, and 12. The HUC12 watersheds with the highest 
storage volumes are predominantly located in North Central Iowa and certain areas of the Missouri 
and Mississippi River floodplains. However, these areas also exhibit relatively high pool area 
values, which might generate resistance to ORS implementation among landowners due to the 
larger areas inundated during heavy precipitation events. The maximum number of ORS found for 
a HUC12, HUC8, and a county was 364, 12,513, and 4,216, respectively.   
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Figure 10. Statewide GIS analyses aggregated at the HUC12 level. Number of ORS, flood storage (ac-
ft), pool areas for the 70% ORS (ac), and drainage areas (ac). 

 

 

Figure 11. Statewide GIS analyses aggregated at the HUC8 level. Number of ORS, flood storage (ac-
ft), pool areas for the 70% ORS (ac), and drainage areas (ac). 
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Figure 12. Statewide GIS analyses aggregated at the county level. Number of ORS, flood storage (ac-
ft), pool areas for the 70% ORS (ac), and drainage areas (ac). 

b. Planning Designs 
The Python scripts were executed for six selected HUC12 watersheds (see Fig. 7) and can be 
visualized through the web platform. Our design methodology could not finalize a design (e.g., 
values of D1, D2, and D3) for all the ORS identified by the statewide GIS analyses. This outcome 
is expected since the GIS analyses did not include hydrologic considerations (e.g., design storms, 
time of concentration, runoff generation mechanisms, etc.) and serves as a preliminary 
prioritization approach. In simple terms, the GIS analyses identified good candidate locations for 
ORS implementation, and the hydrologic analysis involved in our planning designs identified the 
best locations among these candidates. Figure 13 summarizes the information generated by our 
planning design scripts for a selected ORS in Mill Creek. This figure shows the structure location, 
expected pool, and corresponding drainage area identified through our statewide GIS analyses. 
Additionally, it presents the values for D1, D2, and D3 calculated using our planning design 
methodology, as well as the inflow and outflow hydrographs for the 500-year storm, demonstrating 
an approximate peak flow reduction of 20%.     
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Figure 13. Planning designs. Example of the information generated by the scripts described in the 
methodology section.  

c. HUC12 Scale Hydrologic Modeling 
The hydrologic simulations were based on high-resolution computational grids that enable 
accurate identification of streams, watershed boundaries, and roads. The smallest computational 
elements cover an area of approximately a quarter of an acre, with larger elements away from the 
stream channel approaching five acres in size. This high spatial resolution was crucial to capture 
the effect of the ORS on the hydrologic response of the HUC12s to heavy precipitation events. 
Each computational surface element was assigned spatially variable land use and topographic 
information, relating the location to overland roughness and land surface slopes. We used the 
National Land Cover Database, 2-m DEMs, and the Soil Survey Geographic (SSURGO) database 
to describe the properties of both the saturated and unsaturated regions. Models were forced with 
50-yr. design storms generated using data from the NOAA Atlas 14 and the SCS/NRCS Type II 
rainfall distributions. All the simulation were run for nine days (216 hours), and the design storm 
was applied during the fourth day. ORS were incorporated using stage-storage-area-discharge 
relationships. For each of the six selected HUC12 watersheds (Figure 7), Figures 14-25 provide 
information on various aspects. These include the dominant land cover, the computational mesh, 
the selected ORS for the simulations, and a comparison of flow peaks predicted by GHOST and 
estimated from StreamStats for 10-year, 50-year, and 100-year return periods. Additionally, two 
hydrographs are presented for each watershed, showing the GHOST model outputs at the 
watershed outlet during the 50-year storm. The hydrographs illustrate both the baseline conditions 
(without ORS) and the model predictions after implementing the selected ORS. By analyzing the 
differences in hydrograph peaks, the flood-reduction benefits of the chosen ORS at the HUC12 
scale can be quantified.  
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North Bear Creek 

 

Figure 14. Left: Dominant land uses in the watershed. Right: Computational mesh and drainage 
areas contributing to the evaluated ORS. 

 

Figure 15. Left: Peak flow comparison at the watershed outlet, showing modeled values (vertical axis) 
versus estimates from regionalization and regression equations (StreamStats). Right: Hydrographs 
at the watershed outlet depicting model predictions for the 50-year storm with ORS and without ORS 
(Baseline) in place.   
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Bear Creek-Soap Creek 

 

Figure 16. Left: Dominant land uses in the watershed. Right: Computational mesh and drainage 
areas contributing to the evaluated ORS. 

 

Figure 17. Left: Peak flow comparison at the watershed outlet, showing modeled values (vertical axis) 
versus estimates from regionalization and regression equations (StreamStats). Right: Hydrographs 
at the watershed outlet depicting model predictions for the 50-year storm with ORS and without ORS 
(Baseline) in place. 

 

 



  19 
 

Middle Branch Boone River 

 

Figure 18. Left: Dominant land uses in the watershed. Right: Computational mesh and drainage 
areas contributing to the evaluated ORS. 

 

Figure 19. Left: Peak flow comparison at the watershed outlet, showing modeled values (vertical axis) 
versus estimates from regionalization and regression equations (StreamStats). Right: Hydrographs 
at the watershed outlet depicting model predictions for the 50-year storm with ORS and without ORS 
(Baseline) in place. 
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Village of Van Horne-Prairie Creek 

 

 

Figure 20. Left: Dominant land uses in the watershed. Right: Computational mesh and drainage 
areas contributing to the evaluated ORS. 

 

Figure 21. Left: Peak flow comparison at an interior point in the watershed, showing modeled values 
(vertical axis) versus estimates from regionalization and regression equations (StreamStats). Right: 
Hydrographs at the watershed outlet depicting model predictions for the 50-year storm with ORS 
and without ORS (Baseline) in place. 
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West Branch Mill Creek-Mill Creek 

 

 

Figure 22. Left: Dominant land uses in the watershed. Right: Computational mesh and drainage 
areas contributing to the evaluated ORS. 

 

Figure 23. Left: Peak flow comparison at the watershed outlet, showing modeled values (vertical axis) 
versus estimates from regionalization and regression equations (StreamStats). Right: Hydrographs 
at the watershed outlet depicting model predictions for the 50-year storm with ORS and without ORS 
(Baseline) in place. 
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Upper West Fork-West Nishnabotna River 

 

 

Figure 24. Left: Dominant land uses in the watershed. Right: Computational mesh and drainage 
areas contributing to the evaluated ORS. 

 

Figure 25. Left: Peak flow comparison at the watershed outlet, showing modeled values (vertical axis) 
versus estimates from regionalization and regression equations (StreamStats). Right: Hydrographs 
at the watershed outlet depicting model predictions for the 50-year storm with ORS and without ORS 
(Baseline) in place.  
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Table 4. Summary of the HUC12 scale hydrologic modeling. DA represents the accumulated area 
contributing to the ORS. Peak flows were extracted from the hydrographs presented in Figures 15, 
17, 19, 21, 23, and 25. 

 

 

 

Figure 26. Left: Number of ORS vs. Peak flow reduction. Right: Percent of the watershed regulated 
vs. Peak flow reduction. 

Table 4 and Figure 26 present a summary of the HUC12 scale hydrologic simulations. On average, 
the evaluated ORS systems provided an 18% peak flow reduction at the watersheds' outlets. It is 
important to note that only a subset of the ORS identified through statewide GIS analyses was 
tested with the hydrologic models. Therefore, there is potential for greater peak flow reduction if 
more structures are evaluated. However, an important conclusion from our modeling results 
indicates that guiding conservation or watershed planning efforts based on the number of ORS 
may not be advisable. Figure 26 (left panel) shows that a larger number of ORS does not 
necessarily correlate with additional peak flow reductions. Our results suggest that a metric better 
correlated with peak flow reduction is the percentage of the watershed regulated by the ORS, as 
shown in the right panel of Figure 26.  

Furthermore, it is important to note that the peak flow reductions presented in our analyses were 
estimated at the watershed outlet. Significantly higher peak flow reductions (e.g., >25%) exist in 
some of the tributaries, particularly immediately downstream of the ORS. This suggests that if 

HUC 12 NAME Area 
(acres)

Number 
of ORS

DA 
(acres)

Regulated 
area (%)

Baseline 
(cfs)

ORS 
(cfs)

Reduction 
(%)

North Bear Creek 20335 53 5282 26.0 8304.6 6942.9 16.4
Bear Creek-Soap Creek 10044 19 2020 20.1 5994.7 5140.0 14.3

Middle Branch Boone River 21706 29 5788 26.7 2261.9 1834.2 18.9
Village of Van Horne-Prairie 

Creek 22333 41 7945 35.6 12825.2 9796.3 23.6

West Branch Mill Creek-Mill 
Creek 19857 45 7684 38.7 7127.0 5842.8 18.0

Upper West Fork West 
Nishnabotna River 25642 71 8118 31.7 6729.2 5682.1 15.6

Peak Flows. 50yr. Storm
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county engineers identify a culvert or bridge repeatedly impacted by flood events and receiving 
water from a relatively small area, a system of ORS upstream from the impacted area can provide 
significant flow reduction and potentially lessen the frequency and magnitude of infrastructure 
damages.     

d. Web Platform 
The IDOT-ORS platform combines visual and data analytics to provide a desktop-like 
environment for managing, visualizing, and analyzing large volumes of geospatial data through 
web-based mapping and visualization features (Figure 27). By using web service APIs, the 
platform ensures interoperability across various information systems. A client tool for these web 
services guarantees consistent data access. We have unified these web services to serve model data 
consistently, allowing end users to access data through a standardized API, regardless of their 
system. 

 

 

Figure 27 Top: Planning designs. Bottom: Inflow and outflow hydrographs for the 100-year storm. 
https://hydroinformatics.uiowa.edu/lab/idot-ors/ 
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The platform stores the geospatial layers developed during the statewide GIS analyses and 
planning design efforts described above. The layers are visualized using the Google Maps API, 
delivering data and spatial layers in formats like KML, geoJSON, or other international standards 
from the Open Geospatial Consortium (OGC). To simplify access, we developed a client library 
of tools that enable users to interact with IDOT-ORS web services. This highlights the 
interoperability of systems adhering to consistent data and API specifications. Additionally, we 
created new visualization and communication tools using JavaScript and Canvas. Figure 27 
illustrates the information accessible via the IDOT-ORS platform. At the top are results from 
planning designs for a selected structure, while at the bottom are inflow and outflow hydrographs 
for the 100-year storm. 

5. CONCLUSIONS AND FUTURE WORK 
The primary goal of the current research was to develop tools to guide, facilitate, and enhance 
the adoption of ORS in Iowa. This project examines various aspects of ORS, which are modified 
culverts that use road embankments as temporary dams to store water and reduce flood impacts. 
Statewide GIS analyses identified approximately 250,000 potential ORS implementation sites. 
The geospatial datasets created by this project are a valuable resource for anyone considering 
ORS implementation in Iowa. These datasets provide information on ORS locations, expected 
pool areas, and the drainage areas associated with the structures, offering a comprehensive 
foundation for planning and decision-making. 

Additionally, we developed a methodology and Python scripts to automate the hydrologic design 
of individual ORS, improving the identification of ORS that offer significant peak flow reduction 
benefits. This project also quantified the peak flow reduction benefits at the HUC12 watershed 
scale for ORS systems, revealing that for a 50-year storm event, peak flows at watershed outlets 
were reduced by approximately 18%. Our modeling results suggest that the area regulated by 
ORS is a more effective parameter than the number of ORS alone for estimating peak flow 
reductions at larger spatial scales. 

Lastly, the research outcomes are accessible and can be visualized through a web platform 
integrated with Google Maps. This platform facilitates the dissemination of results and allows 
various stakeholders to understand the potential of ORS in mitigating flood impacts effectively.    

Several additional analyses can be built upon the findings and products of this research 
including: 

1. Expansion of Planning Designs: Extend the planning design scripts beyond the initial six 
selected HUC12 watersheds to cover all (approximately 1,600) HUC12 watersheds in 
Iowa. This broader analysis will enhance the selection of ORS that can provide optimal 
peak flow reduction benefits. The outcomes can be integrated into the IDOT-ORS 
platform. 

2. Hybrid Modeling Approach: Introduce a hybrid approach combining the process-based 
hydrologic modeling used in this project with Machine Learning techniques. This 
approach can efficiently assess a larger number of HUC12 watersheds across various 
hydrologic scenarios and implementation levels of ORS, leveraging both accuracy and 
computational efficiency. 
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3. Alignment with the POWAR Concept: Coordinate additional research efforts with 
ongoing flood resiliency planning initiatives in Iowa, such as the POWAR concept 
developed by Iowa Homeland Security and Emergency Management. This concept 
focuses on mitigating flood damages through constructed storage (e.g., ORS) upstream of 
vulnerable communities. Aligning additional research on ORS with the POWAR concept 
can guide mitigation investments effectively. 

4. Economic Analysis of ORS: Conduct economic analysis once flood reduction benefits are 
quantified. Perform loss-avoidance or benefit-cost analyses to provide counties and 
communities with data necessary for securing funding to enhance flood resilience. 

5. Water Quality Analysis: Explore water quality aspects of ORS, particularly their impact 
on phosphorus movement from agricultural fields to streams. ORS, by slowing down 
water flow, can enhance sediment deposition and potentially reduce phosphorus 
quantities reaching water bodies. Future research efforts can try to quantify these effects 
to understand their environmental benefits. 

These potential new research projects broaden the scope of the initial research, addressing critical 
aspects of flood mitigation, economic feasibility, and environmental impacts related to ORS 
implementation in Iowa. 
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